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Welcome to the latest edition of my monthly Final Cut Studio newsletter for June, 2009.

The goal of this newsletter is to provide information helpful to the serious user of 
Final Cut Pro. This newsletter publishes each month, past issues are available in 
my store. All software references are to Final Cut Studio 2 unless otherwise noted. 

Please invite your friends to visit my website -- www.larryjordan.biz. There you'll 
find daily tips, latest industry news, and over 450 articles and tutorials to help you 
get the most out of Final Cut!
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WRAP-UP 

WELCOME

It's good to be back... 

Summer is finally here, Apple's released new laptops, detailed what we can expect in Snow 
Leopard, and there's a ton of interesting Final Cut news and gossip.

First, a quick note at the start. I truly enjoy all the comments and questions you send in. I share 
those that seem relevant to a larger audience, but without your feedback this newsletter would 
be a lot less interesting. 

Wile I am very grateful for all your compliments and kind words, I also appreciate when you point 
out errors. I try to make these newsletters as accurate as possible, and with your help, we can. 
(By the way, I update each issue for several days after its initial release, so be sure to check 
back every few days to see what others have to say.)

[ Go to Top. ] 

APPLE DETAILS SNOW LEOPARD - WHAT DO WE NEED TO KNOW?

On Monday last week, Apple detailed the new 
features in Snow Leopard - also known as OS X 10.6.

While there has been lots of press coverage on this, I want to highlight a few points that are 

http://www.apple.com/macosx/


relevant for Final Cut Pro users. This was sparked by a question from Andreas Schmidt, who 
wrote:

Yesterday Apple announced Snow Leopard and Quicktime X. Do you know or 
have an idea if Final Cut Studio 2 will run under that OS or will it be necessary in 
order to run Snow Leopard to buy Final Cut Studio 3 once its announced?

Larry replies: First, Snow Leopard runs on Intel-Mac systems only, so if you are using a G-5 or G-
4, you won’t be able to run the new operating system. (In fact, for G-4 systems, I'd suggest 
staying with OS X 10.4.11.) 

Second, Snow Leopard uses a (relatively) new language called Cocoa. However, much of Final 
Cut Studio is written in an earlier language called Carbon. So, if you want to run Snow Leopard, 
you’ll need to upgrade Final Cut to the latest version - which has not yet been announced.

(Cocoa, in general, is a good thing. For instance, Carbon limits the total amount of memory that 
an application can access to 4 GB; Snow Leopard supports TERAbytes of RAM.)

Finally, in answer to when a new version of Final Cut will be released, Apple does not tell me the 
ship date of new versions of FCP before they announce it to the world. But if I were to GUESS, I 
would say that we won’t learn of a new Final Cut Studio version until Snow Leopard is shipping. 
So, for me, I’m expecting an FCS upgrade in the October time-frame.

Jonathan Tyrell reminds me that Snow Leopard will still support many 32-bit applications, so 
that you won't necessarily need to update everything when you move to Snow Leopard.

I am really looking forward to this version of the OS -- however, keep in mind that there's still a 
ways to go before release. And no client has ever paid extra for us to edit on the latest version of 
anything.

UPDATE - June 16, 2009

Tom Wolsky adds:

An important feature in Snow Leopard for video pros is the change of the default 
screen gamma.

Larry replies: Thanks, Tom, I forgot that. 

UPDATE - June 23, 2009

My recent thoughts about the relationship between Snow Leopard and the next version of Final 
Cut Studio generated a lot of comments -- especially on other forums. For instance, here's an 
example from KenStone.net:

http://www.kenstone.net/discussions/read.php?3,13183,13183#msg-13183

Thanks for all your comments and thoughts on this. My information for my posting was based on 
talking with both programmers and knowledgeable engineers at a variety of different companies. 
However, I would be foolish to ignore the expertise of Philip Hodgetts and others. My goal in both 
my blogs and newsletters is to be as accurate as possible and, when errors exist, to correct them 
quickly.

Philip Hodgetts did a detailed analysis of this issue in his blog a couple of days ago that I 
strongly encourage you to read:

http://www.kenstone.net/discussions/read.php?3,13183,13183#msg-13183


http://www.philiphodgetts.com/2009/06/21/what-about-final-cut-studio-and-snow-
leopard/ 

My bigger point was two-fold: to explain why I felt the next version of FCP would not ship until 
after Snow Leopard and to begin to explore the impact Snow Leopard may have on Final Cut 
editors. The reality is that we won't know the impact until both products are announced and 
shipped. Until then, I'm grateful for everyone's comments.

[ Go to Top. ] 

SPEND A DAY LEARNING WITH LARRY

One of the most frequent requests I get is to present a Final Cut 
seminar that covers material not presented as part of the 
traditional Apple training classes.

So, in answer to these requests we've created two new seminars - 
at a GREAT LOW PRICE - $79 for the entire day!

�●     Wednesday, June 24 - Woodland Hills, CA
�●     Tuesday, July 28 - Santa Ana, CA

Now is the best time to improve your skills -- while the economy is 
slow and clients are scarce. Because when we are busy working 
there’s no time left to study.

A full day of training with LOTS of time for questions and discussion and ONLY $79! Frankly, we 
are doing a test to see if lowering our prices makes it easier for more people to attend. 

Click here for the agenda and registration. 

We only have about 15 seats left in Woodland Hills - please register soon to reserve your seat.

BREAKING NEWS! Bruce Nazarian joins us in Santa Ana to discuss creating Blu-ray Discs. 

Note: Due to many requests, we are currently working on creating a seminar in 
Northern California for late July - early August. We'll send you a note when we 
get this finalized. Thanks to Silverado Systems for helping to set this up! 

Great training at a great low price! Now's the perfect time to learn something new. 

Click here to learn more!

[ Go to Top. ] 

TECHNIQUE: CREATING A PICTURE-IN-PICTURE EFFECT  
THAT MOVES USING MOTION TAB KEYFRAMES

One of the fun things about teaching is helping students discover concepts I've known about for 
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a while, but are still new to them.

That thought is the foundation for this technique - getting a piece of video to move around the 
frame. Along the way, I'll try to illustrate some techniquese that some experienced users may 
have forgotten.

This tutorial has several parts:

�●     Setting up your clips
�●     Changing the size of a clip 
�●     Positioning a clip
�●     A discussion of Action and Title Safe
�●     Getting an image to move
�●     Adding curves  

SETTING UP YOUR CLIPS

When you are building an effect in the timeline, the order in which you stack clips makes a 
difference.

Clips on higher tracks are in front of clips on lower tracks. In other words, the stacking order of 
your clips determines foreground and background.

For instance, here I have a gold background clip on V1 and a foreground clip of a snowboarder 
on V2.

By default, all clips in Final Cut are 100% full screen and 100% opaque. This means that when 
two clips are stacked, the upper clip totally blocks the clip(s) below it.

Therefore, if we want to see any background (lower track) clips, we need to adjust the highest 
level clip first. This can be done using a variety of tools (such as cropping), filters (such as 
mattes), or settings in the Motion tab. 

CHANGING THE SIZE OF A CLIP

Probably the easiest way to see both clips at once is to change the size of the top (V2) clip.



Note: By the way, the reason I refer to clips using V1 or V2 is that is the label of 
the track on the left side of the Timeline. I refer to tracks based on the right-hand 
track labels in the Patch Panel.

So, to change the size of a clip, double-click it to load into the Viewer, and click the Motion tab. 
There are ten different setting groups in the Motion tab. However, the three that get used the 
most are:

�●     Scale - the size of the clip
�●     Rotation - the angle of the clip
�●     Center - the position of the clip

There are several ways to change the size of a clip:

�●     Move the Scale slider
�●     Type in a value in the Scale data entry box
�●     Adjust the size of the image in the Canvas (more on this in a minute)

In this case, we'll make the V2 clip smaller by changing its Scale to 40%.

Important note: The highest quality of any video clip is when it is scaled to 100% 
or smaller. Scaling above 100% very quickly degrades image quality -- especially 
for standard-def images. Try really, really hard not to enlarge clips beyond 100%.

POSITIONING A CLIP

To change the position of a clip within the frame, you need to know how Final Cut positions it in 
the first place. Final Cut positions clips based upon the CENTER of the image. And it uses as its 
starting point the exact center of the frame - a point it labels 0,0.

Putting an image at a Center of 0,0, means that the center of the image is exactly in the center of 
the frame. And, if the image has a scale of 100%, that means that the image will be centered in 
the frame and fill the frame.

Note: It is possible to move the Center point to a different location than dead 
center by altering the Anchor Point. The Anchor point is the point around which an 
image rotates or scales. By default, this is at the center of the frame (0,0). 
However, moving the anchor point is a subject for a future tutorial. For now, we'll 
leave it at its default setting of 0,0.



So, to change the position of a clip, we can enter new values in the Center data entry box. The 
left-hand box controls horizontal position, and the right-hand box controls vertical position. 

Negative numbers in the left-hand box move an image left. Positive numbers move the image 
right. Negative numbers in the right-hand box move an image up. Positive numbers move the 
image down.

So, to place a 4:3 NTSC DV image so that the center of the image sits in the middle of the far left 
edge of the frame, the Center would be -360, 0. To place the center of the image in the middle of 
the bottom edge of the frame, the Center would be 0, 240. Up and left are negative numbers, 
down and right are positive numbers.

Note: For those of you following along at home, I'm working with 4:3 NTSC DV - 
because it allows me to use screen captures small enough to fit into this 
newsletter. A 4:3 NTSC DV image is 720 x 480 pixels.

For our example, let's tuck it in the top left corner of Action Safe by moving the image to -180, -
120.

Here's an easier way to move an image. Go to the far right pop-up menu at the top center of the 
Canvas, and switch it to Image+Wireframe. This allows you to grab an image in the Canvas and 
drag it where you want it to go.

Other things you can do with Arrow tool in the Canvas in Image+Wireframe mode include:

�●     Scale an image - grab a corner and drag 
�●     Rotate an image - grab NEAR a corner and drag.
�●     Move an image - grab inside an image and drag

Note: Using tools from the Tool palette, you can also Crop and Distort an image. 
In fact, the Distort tool also allows you to move the Anchor point by simply clicking 
and dragging.

However, for me, the easiest way to move an image is to click the cross-hairs next to the Center 
data entry boxes. Notice how it turns a darker shade of gray? 

Now, simply click, hold, and drag the image in the Canvas where you want it to go. This way, I 
don't need to worry about the Canvas pop-up menu setting. I can move the image and see the 
numeric read-out in the viewer as I move the image. Plus, many other filters and settings use this 
same icon to set position. 



A SIDEBAR - WHAT ARE THESE STUPID RECTANGLES??

Um, wait a minute. What's Action Safe and what are these blue rectangles doing here?

To display both Action and Title Safe, go back to that same far right pop-up menu in the Canvas 
and select "Show Title Safe."

Action Safe - the outer rectangle - is 5% in from all edges of an image and represents that 
portion of the frame that is often lost when images are displayed to an analog device, such as 
CRT televisions and projection systems (both digital and film).

Title Safe - the inner rectangle - is 10% in from all edges of an image and represents that portion 
of an image that is often lost on older CRT televisions, which tend to enlarge images as the TV 
set ages.

It is considered good practice to keep all essential action (actors and movement) within the 
Action Safe boundary. Further, it is considered REALLY good practice to keep all essential text 
(titles and logos) within the Title Safe boundary.



But wait just a minute, I hear you saying. This is the new world of digital television -- LCD and 
LED displays -- and the Internet; surely we don't need to worry about this stuff now.

Well, much as we would all like to believe that we are past all this, it just ain't true. There are 
BILLIONS of older TV sets still in use where the rules of Action Safe and Title Safe still apply. 
Also, anything which is projected needs to allow for edges of the image to shoot off the screen.

So, for many, many years to come we are in the worst of all situations: we need to create perfect 
images edge to edge for the web and digital TV sets, while keeping essential text and logos 
within Title Safe so that older sets can still display them.

You are welcome to grumble, those of us in the industry have been complaining about this since 
the dawn of television... not that complaining will do any good, but it may make you feel better.

GETTING AN IMAGE TO MOVE

Now that we have our image scaled and positioned, we need to get it to move. In order to do 
that, I need to define a term: Keyframe.

A Keyframe is a point of change during playback -- and we always use keyframes in pairs.

If nothing changes during playback, you never need keyframes. For instance, in this example, if 
we want to leave this image parked in the upper left corner, we would set it there and be done 
with it.

We only need to use keyframes if we want an image to move, say, from the upper left corner to 
the upper right corner during the playback of our sequence. And, just as you need to know both 
where you are starting from and where you are going when you leave on a trip, you also need a 
starting keyframe and ending keyframe when you want something to move during playback.

So, let's animate a change in position for this image by setting two Center keyframes -- one 
where we want it to begin moving and the other where we want it to end.

First, we may need to make the Motion tab wider so we can see the Keyframe section. To 
change the size of a window, grab the lower right corner, on the three diagonal lines, called the 
Thumb, and drag to the size you need.

Notice that the Motion tab divides into two sections: the settings side, on the left, and the 
keyframe side, on the right. The light gray area on the right represents the portion of the clip in 
the Timeline.

Position the playhead in the Motion tab where you want to set your first keyframe. In our case, 
we want the keyframe at the start of the clip. So, make sure the Motion tab is selected and type 
Shift+I -- this jumps the playhead to the In of the clip. 



Click the open diamond to set a keyframe. When the playhead is parked on a keyframe, the 
diamond becomes solid green. Click it again, and it will delete the keyframe it is parked on.

Then, press Shift+O to jump the playhead to the out of a clip. 

We can either set a keyframe first, then move the clip to a new position. Or, simply move the clip 
and FCP will create a keyframe automatically at the position of the playhead. I generally create a 
keyframe first, which reminds me that I WANT to create a keyframe at that position. But either 
way works great.

In this case, with the playhead at the end of the clip, click the Center cross-hairs to select them 
and drag the image to the top right corner of Action Safe. (The Center numbers are 180, -120.)

What Final Cut has done, invisibly, is to create a motion path -- that is, a connection between the 
two keyframes. You can see this path by switching the display of the Canvas to either Image
+WireFrame or Wireframe in the far right pop-up menu.

When you play your sequence, your clip moves along the motion path, starting at the first 



keyframe and ending at the second.

While there is no practical limit to the number of keyframes you can add to a cilp, in general, try 
to keep the number of keyframes as low as possible. This tends to keep movement smoother.

THROWING A CURVE

The best way to move between keyframes is using the small left- and right-pointing arrows on 
either side of the diamond. Dragging your playhead between keyframes raises the possibility of 
placing the playhead close to, but NOT on, a keyframe, which means when you change 
something you are creating a new keyframe, which can be really, REALLY confusing.

Instead, click the small arrows for navigation. You can also try the keyboard shortcuts Shift+K 
(next keyframe) and Option+K (previous keyframe).

Anyway, put your playhead on the last keyframe and drag the image down to the lower right 
corner. Notice the new Center numbers are 180, 120? Are you starting to see a pattern here? 
Many times, we can easily and symmetrically move an image by just changing the Center 
number from positive to negative.



To make this next section easier to see, I'm going to switch to Wireframe mode. This just 
displays the frame of an image, without the picture. This can often make creating effects much 
faster - as this doesn't require rendering - and easier to see - since you are watching objects 
move, rather than the images themselves.

Now, Control+click the small green circle (which is the indicator for a starting keyframe) and 
select Linear. This creates a Beziér control point and adds two small dots to the motion path - 
both darn-near-impossible-to-see blue dots. 

Grab the dot farthest from the keyframe and drag and you'll turn the motion path into a curve. 
Drag the control point around and watch what happens to the shape of the curve.

Do the same thing - control-click and select Linear - for the lower keyframe and drag to set a 
curve for the lower keyframe.



In this case, I created an image in the shape of an S. You can use keyframes and Beziér control 
points to create an almost unlimited number of shapes. 

This same technique can be uses to have something fly from off-screen to on-screen -- or make 
an exit by flying off-screen.

The techniques shown here are simple to learn. Yet the combinations are almost endless.

Have fun.

Note: By the way, many Filter and Motion tab parameters allow their height to be 
adjusted. If you see a thin double-line separating two parameters, drag it down to 
increase the height of a parameter setting. For instance, both the Scale and 
Rotation parameters have adjustable heights.

UPDATE - June 16, 2009

Tom Wolsky also points out:



For the PIP (Picture-in-Picture) effect I'd like to mention Piero Fiorani's free 
plugins. He's primarily an FCE user and some of them are really for that 
application, but he has a Quarter PIP filter as well as an easy-to-use motion 
control (Ken Burns) filter. http://web.mac.com/piero.fiorani/PieroF_FCE_Effect

Larry replies: Thanks, Tom. 

[ Go to Top. ] 

LARRY RELEASES ELEVEN NEW VIDEO TUTORIALS --  
PLUS THREE BUNDLES!

I just released ELEVEN new video tutorials on Final Cut Studio -- PLUS a new Soundtrack Pro 
bundle that saves you 30% on the titles purchased separately.

I was surprised at the high level of interest in Soundtrack Pro, so I made a point to create several 
more STP titles this month. My newest tutorials are:

�●     Learning how to read the video scopes in Final Cut Pro 
�●     Automatic Color Correction in Seven Steps Inside Final Cut Pro

 
�●     Introduction to the Particle System in Motion 3

 
�●     Creating Flash Movies Using the Adobe Media Encoder
�●     Converting an FCP Project to an Earlier Version of FCP using XML

 
�●     Sending Files to Soundtrack Pro from Final Cut Pro
�●     Getting Different Mics to Sound the Same Using EQ Matching
�●     Using Busses, Sends, and Reverb In Soundtrack Pro 2
�●     Using Submixes to Group and Control Tracks 
�●     Editing Problem Frequencies Using the STP Spectrum Tool
�●     Improve Audio Levels with SoundTrack Pro's Limiter Filter 

You can find the complete list of all my video tutorials here.

My most popular tutorials this month were:

�●     Preparing Still Images
�●     Larry's Favorite Tutorials Bundle
�●     Retouching Video in Photoshop Extended
�●     Minimizing the Spinning Beach-ball
�●     Exporting an H.264 Movie from FCP or QuickTime 
�●     Soundtrack Pro Bundle #1

With 40 tutorials to choose from, and priced at only $4.99 each, there's sure to be at least a 
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couple that can help you solve the problems you're having.

Click here for a list of all my tutorials.

Click here for a list of bundles and SAVE 30% 

NOTE: Each title is a QuickTime movie that runs 6-12 minutes and can be 
instantly downloaded. Keep in mind that the best time to learn is when things are 
slow. More titles coming every week!

[ Go to Top. ] 

BLOG POST: TAKING THE PRO OUT OF THE MACBOOK PRO

[ Note: I posted this to my blog June 12, but this is important for all of us,  
so I wanted to share it with you here. ] 

Apple this week announced revisions to their 
13″ and 15″ MacBook Pro laptop line.

Most of the time, when these sorts of things get announced, I just nod my head, acknowledge 
the new release and move on. I’m not buying laptops all the time, so this stuff doesn’t affect me.

However, in the last two laptop releases Apple is starting to reveal a trend which is very troubling 
to me as someone who uses Mac gear to edit audio and video — they are taking away the ports 
I need to connect my stuff.

This began with the laptop update prior to the most recent one with the removal of FireWire 400 
ports. Now, in itself, this isn’t a bad thing. FireWire 400 is slow, with a limited cable length. The 
problem was that they didn’t replace the port with a second FireWire 800 port.

This means that I can’t connect a camera and a second hard drive to my computer without 
purchasing a FireWire hub. And a hub always runs at the speed of the slowest device connected 
to it. As well, there are legions of problems with editing video on a single hard drive, unless you 
are resigned to only editing DV or HDV. ProRes certainly can’t be edited on a single-drive 
system. Nor can any audio projects with more than a few tracks. Nor can many other HD video 
formats.

Then, in the latest laptop release for both the 13″ and the 15″ laptop, Apple removed the high-
speed Express 34 card and replaced it with the much, Much, MUCH! slower SD card port. The 
SD card ports runs, according to Apple, at a MAXIMUM of 30% of the speed of an Express 34 
card.

How can Apple call a laptop a PROFESSIONAL system when it has fewer ports and the ports it 
has are slower? They create computers with great software, blindingly fast CPUs, great graphics 

http://www.larryjordan.biz/training/online_tutorials.html
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cards, then reduce the ways to connect external gear!

This is foolish and short-sighted.

Yes, Apple needs lower cost systems to meet the needs of the broader market. But, they also 
need systems that meet the needs of video and audio professionals. It makes no sense to buy a 
system that - out of the box - is inadequate for day-to-day video production. Yet Apple describes 
this as their “Pro” line of laptops.

Apple would say that they have the 17″ laptop. True, but disingenuous. The 17″ is too big to 
easily travel with, has a screen resolution that exceeds most video projectors which makes it 
totally impractical for training, and costs more than the 15″ which, up until the latest releases, 
met our needs for ports and speeds.

Apple might also counter saying that they offer the fully expandable Mac Pro line of computers. 
While true, this misses the whole point of having a PORTABLE computer for video editing in the 
field.

If you feel that Apple is short-changing its professional market, feel free to share this - or write 
your own - or contact Apple.

For me, though I need a new laptop, none of the current models are attractive for video editing. 
I’m going to hold off buying until Apple releases a system I can use or I’ll just buy an older 
MacBook Pro - used.

UPDATE - June 18, 2009

Having read my concerns about the latest MacBook Pro versions, Steve sent me a link that we 
can use to send feedback to Apple. 

Feel free to share your thoughts and concerns with them - more importantly, share this link with 
your friends and associates. The more people that Apple hears from, the more likely they are to 
improve the next version of the MacBook Pro.

http://www.apple.com/feedback/macbookpro.html

UPDATE - June 16, 2009

Zak Ray writes:

Larry, in regards to the new Macbook Pros, let's not forget a few important facts:

1.  FireWire is back with the new MBPs, so the lack of Express34 doesn't hurt 
as much.

2.  Less than 10% of the Mac user base was utilizing the Express34 slot, 
according to Schiller. Apple is a company, in it for the money just like any 
other; if only a small percentile of their users are utilizing an expensive 
component, it just doesn't make sense to keep it. 

3.  The reduction of the SATA interface will have very little effect on most 
users, as most internal HDDs can't get past the 1.5 Gb/s barrier anyways. 
The only people who might take a performance hit are those who use 
SSDs-- which, while you are correct that they are much more expensive 
right now than standard HDDs, you are mistaken in regards to speed-- they 
are actually faster than standard HDD.

Larry replies: Thanks, Zak for your thoughts.

http://www.apple.com/feedback/macbookpro.html


My concerns are that the number of FireWire ports on the computer have been reduced from two 
to one, making life difficult for editors acquiring from FireWire cameras and decks. 

Second, while it is true that the majority of laptop users did not use Express34 gear, my feeling is 
that the 10% Schiller referenced were all high-end media producers (audio and video) that need 
the performance. 

I don't object to creating low end systems -- I object to making a computer slower and less 
configurable and calling it "Pro." 

Peter Neill writes:

You mention the demise of Firewire ports on the new MacBook Pros.

Here in the UK it is becoming increasingly difficult to source firewire disc drives. 
I'm not saying it's impossible, but if you walk into any High St computer shop or 
warehouse, you'll be hard pressed to find one.

Is there anything wrong with using USB drives? I know that it's more likely that a 
firewire drive can be powered by the computer, but we probably wouldn't want to 
power one from a laptop for any period.

Larry replies: Thanks, Peter, for writing.

The problem with using USB is that when compared to the speed of a FireWire drive, USB drives 
on the Mac are much, MUCH slower. This differs from the PC, where USB is quite quick. 

Tom Wolsky adds:

Rather than a hub, most cameras, except for the stupid Canons, work better for 
capture when they're daisy-chained through a drive rather than on a hub or even 
another port on the same bus. The SD slots are for ingest of video and stills which 
is being shot on these cards. Currently [SD is] the most popular recording media 
for both.

Larry replies: Thanks, Tom. 

UPDATE - June 23, 2009

After sharing my concerns about the latest round of Apple MacBook Pro laptops, yesterday 
Apple released:

MacBook Pro EFI Firmware Update 1.7 addresses an issue using drives based on 
the SATA 3Gbps specification with the MacBook Pro introduced in June 2009. 
This update allows drives to use transfer rates greater than 1.5Gbps, however 
Apple has not qualified or offered these drives for Mac portable computers, and 
their use remains unsupported. All previous and current Apple portables with a 
SATA drive interface include a SATA 1.5Gbps hard drive. 

iMac EFI Firmware 1.4 Update addresses issues where iMac computers with ATI 
Radeon HD 4850 graphics intermittently stop responding and addresses wake-
from-sleep issues in Boot Camp. 

Here's the link to learn more: http://support.apple.com/kb/HT3561

http://support.apple.com/kb/HT3561
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REMINDER: BOOKMARK MY BLOG

By the way, if you haven't visited my blog recently, click 
here to take a look. While I don't write every day, I do try to 
keep you informed on our news, plus gossip in the industry.

It's also on our RSS feed, so feel free to bookmark it. Plus, 
you are ALWAYS welcome to add a comment.
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THE TEN [ AUDIO ] RECORDING COMMANDMENTS 

During NAB, when I was interviewing people for my podcast, the Digital Production BuZZ, I had a 
chance to talk with Ric Viers. Ric is an acknowledged sound effects recording master, president 
of Blastwave FX, and the author of The Sound Effects Bible.

During the interview he gave me a copy of the book to look over. Recently, I found myself with 
some spare time and starting dipping into it.

Almost immediately, I discovered his chapter titled The Ten Recording Commandments which 
contain rules so helpful that I want to share them with you here.

Ric writes:

These ten commandments have proved irrefutable over the years. They are each 
equally important as individual rules, but even more powerful when used together. 
The use of these commandments will result in top-notch, professional recordings.

1.  Thou Shalt Have a Pre-Roll and Post-Roll of Two Seconds 
on Each Recording.

2.  Thou Shalt Record More Than You Need.
3.  Thou Shalt Slate Every Take with as Much Information as 

Possible.
4.  Thou Shalt Check Thy Levels Often.
5.  Thou Shalt Listen to Thy Work by Always Wearing 

Headphones.
6.  Thou Shalt Eliminate All Background Noise.
7.  Thou Shalt Not Interrupt a Take.
8.  Thou Shalt Point the Microphone at the Sound.
9.  Thou Shalt Check Thy Equipment Before Going Into the 

Field.
10.  Thou Shalt Remember the Copyright Laws to Keep Them 

Unbroken.

Larry continues: If creating professional-grade sound effects is of interest to you, you need to 
check out this book. Its filled with solid, practical suggestions and lots of great examples taken by 
someone who has spent years in the field.

http://www.larryjordan.biz/blog
http://www.larryjordan.biz/goodies/blog.html
http://www.larryjordan.biz/goodies/blog.html
feed://www.larryjordan.biz/feed.xml
http://www.digitalproductionbuzz.com/
http://www.blastwavefx.com/


Even better, its fun to read.

The Sound Effects Bible, Ric Viers, Published by Michael Wiese Productions, 
2009.  
(ISBN 978-1-932907-48-3)
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TECHNIQUE: USING SUBMIXES IN SOUNDTRACK PRO 2

A submix is a special track inside Soundtrack Pro that collects audio from one or more other 
tracks for additional processing or output.

Think of a submix as a way to group tracks.

By default, there is always at least one submix in every multi-track project. Labeled Submix 1, 
it's at the bottom of all the tracks in a project. Most of the time, we treat Submix 1 as the master 
output of our mix. But it really isn't, and that's what I want to talk about in this technique.

WHERE IS A SUBMIX?

Wedged in between Busses (which is empty by default) and Master, which is hidden by default, 
is Submix 1. It has a header similar to a track, except that you can't record to it.

The way that STP is normally wired, all the outputs from the tracks above Submix 1 automatically 
channel their audio into Submix 1. This essentially means that Submix 1 acts as the final 
assembly stage before output.

And, unlike the Master output, which only allows you to control final output volume, submixes can 
hold filters, change panning, levels, and can be set to output from one to six tracks of audio.

However, and this is a big gotcha', Apple defaulted the output of Submix 1 to six channels (that 
is, surround sound), with no way to change the default. This means that if you only need one or 

http://www.amazon.com/Sound-Effects-Bible-Create-Hollywood/dp/1932907483/ref=sr_1_1?ie=UTF8&s=books&qid=1244865213&sr=8-1


two channels output, you MUST remember to change the output to the appropriate number of 
channels.

Note: I'm REALLY hoping Apple allows us to set this as a default in the next 
version of Soundtrack. This surround default just drives me nuts.

WHY USE MULTIPLE SUBMIXES

Just as we use folders to group layers in Photoshop or Motion, we can use submixes to group 
tracks. For example, if we want to fade a group of tracks at the same time, we could either do so 
one track at a time, which makes it really hard to make changes quickly, or group all the tracks 
together into a submix, then fade the submix.

Or, instead of applying effects to individual tracks, we can apply an effect to the entire group; for 
example, this works really well for reverb.

Or, we can use submixes to create multiple outputs of our mix; such as a dialog mix, effects mix, 
and music mix. These discrete mixes are sometimes called "stems."

EXAMPLE 1 - USING A SUBMIX TO FADE A GROUP OF TRACKS AT THE SAME TIME

Here's a six track mix I've assembled for this example. It has two tracks of dialog, two tracks of 
effects, and two tracks of music. There's no magic to this number o ftrackss, the process is the 
same regardless of the tracks you use.

Let's say we want to fade all our effects tracks to black at the same time. Here's how.



1. Because we want some tracks grouped and filtered, while other tracks are not filtered, we 
need two submixes. So, go to Multitrack > Add Submix.

2. Be sure your track height is not set to the smallest setting, otherwise you won't see the 
controls I'll be writing about.

3. While not required, it is very helpful to label your tracks and submixes. In this case, I clicked 
the name of the track to select it, then changed Submix 1 to Effects, and Submix 2 to 
Everything Else.

4. Now, we need to assign each track to a submix. Because we want all our effects tracks to be 
grouped together, we'll assign all our effects tracks to the Effects submix, and the other four 
tracks to the Everything Else submix. To do this, click the double-pointed arrow in the lower right 
corner of the track header and assign each track to the appropriate submix.

5. Once all the tracks are assigned, as a test play the mix and slide the Effects submix volume 
slider back and forth. Notice how this changes the volume of your effects without changing the 
volume of anything else.



6. Click the small right-pointing triangle in the upper-left corner of the track header to reveal the 
volume envelopes for this submix. This is exactly the same as, but a different color from, the red 
rubber bands that we can adjust in a Final Cut timeline. 

7. Scroll to the end of your mix and add two keyframes, one where you want your fade to start 
and one where you want your fade to end. You add keyframes by double-clicking on the purple 
line. As with Final Cut, set a keyframe by dragging it.

Ta-DAH! Done. 

You have now faded all your effects tracks to black at the same time. While you would not 
generally do this if you only had one effects track, as soon as you start creating multiple tracks, 
this becomes a VERY useful technique.

EXAMPLE 2 - USING A SUBMIX TO APPLY A FILTER TO A GROUP OF TRACKS

Next, let's say that we want to apply a limiter filter to all the dialog tracks. I could apply the filter to 
each track, but, it is faster, and less computer-intensive, to group all the dialog tracks, send them 
to a submix, then put the filter on the submix.

1. Since we now need to separate dialog from the other tracks, let's create another submix (type 
Option+Command+T) and rename this new submix Dialog.



  
  
  
  
  
  
  
  
  
  

2. Then, and this is not necessary but, I like having my submixes emulate my general layout, and 
I always put my dialog tracks on top. So drag the green vertical bar of the Dialog submix track 
header up until a faint blue bar appears above the Effect submix. It is easy to change the 
stacking order of submixes by simply dragging them. However, unlike video cilps, the stacking 
order of audio tracks has no impact on final output. 

3. Here, too, we need to assign tracks to submixes. So, click the double-headed arrow on the 
right side of the track header and assign the two dialog tracks to the Dialog submix.

4. Select the Dialog submix by clicking the track header. (See how it turns to a light gray, 
indicating it is selected?)

5. From the Effects tab (in the Left Pane) select Dynamics > Limiter. You've now applied a 
Limiter filter to the submix of the dialog tracks, but none of the others. 

Note: Some filters work better when you route them through a Send, which allows 
you to vary the amount of audio going to the submix. Reverb would be a good 
example of this. However, this technique is just focused on showing how submixes 
work, so I'm ignoring sends for the moment.

Here's a video tutorial that shows you how to use the Limiter filter.

Here's a video tutorial that shows you how to use submixes to add reverb.

EXAMPLE 3 - CREATING SEPARATE STEMS OF YOUR MIX

In this example, I want to illustrate how to create separate mixes for each of your main elements 
- dialog, effects, and music.

You are already organized for this by creating a submix for each group. The only question now is 
how to output them -- and that is surprisingly easy. Here's how.

1. Once your mix is complete, save your Soundtrack Project file (Command+S).

2. Go to File > Export (or press Command+E).

3. Locate a folder to hold your audio files. There will be one file for every submix. 
In this case, I created a folder called "My Project Audio" and named the files "My 
Project Stems."

http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=130
http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=131


4. Lower in this same dialog, change the output from Master Mix to All Submixes. 
This will output each submix to its own file. Set other key settings to output as 
AIFF, 16-bit, 48 kHz sample rate.

5. Click Export to output your project.

6. Open up the My Project Audio folder, inside it is a folder named My Project 
Stems and inside that are files for each submix.

CONCLUSION

I don't use submixes for every project I create, only for the more complex ones. But, as you've 
seen here, submixes can provide a tremendous amount of control, which makes mixing really 
complex projects reasonably straight-forward and very easy.

Note: By the way, I've created a video tutorial illustrating the concepts in this 
article. You can learn more about it here.

http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=131
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ANOTHER TECHNIQUE FOR RESTORING FADING HARD DISK DATA

Last summer, I learned and shared with you that when a hard disk is unplugged and stored on a 
shelf a process called "bit flux" will slowly let the magnetic data stored on the hard disk fade 
away. (Here's the original article.)

While the time this fading takes varies, it can be as short as one year or as long as three. What is 
sure is that your data will slowly disappear until the hard drive is no longer useable. (Note: if your 
hard disk is always, or mostly always, powered on and attached to your computer, this is non-
issue.) 

The way to prevent this problem is to connect your hard disk to your computer about once a year 
and refresh all the sectors on the drive.

Recently, Dave Fix, Senior Systems Administrator at Mr. X, Inc. sent me the following which can 
help with this restoration process.

In your article about refreshing hard disk storage, I thought I'd let you know that 
another way you can refresh storage is to run the badblocks command on a hard 
drive. This should be 100% safe, as it does NO writing to the drive (unless a bad 
sector is detected, at which point it will re-write the bad-sector map on the disk).

The command is: sudo badblocks -b 4096 -p 1 -c 32768 /dev/rdisk0

I asked Dave to explain what the various parameters did. He replied:

-b 4096 : Sets the block size to 4096 bytes. This can improve the speed at which 
the tool operates. 
 
-p 1 : Tells it to perform one pass. If you want to perform more than one pass, set 
this number higher. 
 
-c 32768 : Tells it to test 32768 blocks at a time. The default is 10. Telling it to test 
more at once can take up more memory, however. If you're running a lower-
memory system (less than 2GB RAM), set this to 8192. 
 
/dev/hda : is the hard drive to be tested.

I then said that I am always VERY reluctant to advise running terminal commands due to the 
potential for complete disaster. Does this command, as written, have the potential to do any 
harm?

Dave replied: 

badblocks, by default, will perform a read-only non-destructive test of the hard 
drive, and we don't add any parameters that could affect that operation, so this 
should be perfectly safe. :)

Larry adds: This command is run from the Terminal. If you have never run a terminal command 
before, show this to a friend who has and work on this together. 

http://www.larryjordan.biz/articles/lj_hard_disk_warning.html


IMPORTANT NOTE: The phrase "/dev/rdisk0" is the name of the hard drive you 
are refreshing. To determine what to enter here, go into Disk Utility (in your 
Applications/Utilities directory). You will see all your mounted disks in the left 
column. This list is indented. It will say something like "232.9 GB Hitachi" and 
underneath that will be your volume name indented, like "Macintosh HD". 
 
- Click on the top line (the "232.9 GB Hitachi" line in my example)  
- Click on the Info button  
- Read the "Disk Identifier" line. It will say something like "disk0".  
 
Where Disk Utility is saying "disk0" or "disk1" or "disk2", ... put an "r" in front. This 
is the name you use in the command (/dev/rdisk0 in this case).
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REFLECTION: THE END OF TELEVISION AS WE KNOW IT

OK. This isn't really technical, and has nothing to do with Final Cut, but I was thinking about this 
last week and wanted to share this with you...

Last Friday, June 12, marked the end of analog television broadcasting in the US. Tomorrow, all 
over-the-air transmission becomes digital. I'm all in favor of technology and change, but I wanted 
to say good-bye to an era.

I got my start in broadcast television, but even before then, growing up in small towns in 
Wisconsin, I remember how magical TV seemed. First, in the days of black and white, being able 
to pull images out of the air with thin pieces of wire - and family rituals developed around 
EXACTLY how those rabbit ears should be pointed to get the best signal, NOT that my brothers 
were EVER right, of course - then, came color.

When color television first appeared, the TV set was the size of a bookcase laid on its side. More 
than entertainment, it was a sizable piece of very expensive furniture. Filled with strangely 
glowing tubes, it radiated both heat and a sense of unlimited power.

I still remember, as a small child, the first color television that came into our small community of 
Sturgeon Bay, Wisconsin. The TV was displayed in a local furniture store and was four feet high, 
three feet deep, and eight feet wide. It had about a 15 inch screen and weighed about 800 
pounds. The store owner, Katie Malvetz, was a friend of the family and, when NBC announced 
they would be playing the Wizard of OZ in COLOR for the first time on network television, Katie 
decided to turn this into a social event.

She and a team of men moved the TV from her showroom to her living room, then she invited 
her friends to watch with her. When the movie started, there must have been 30 people - adults 
and kids - in the room. And when Dorothy opened the door to step from black-and-white Kansas 
into colorful Oz... well, there wasn't a dry eye in the house.

To this day I remember how stunned I was to see color images invisibly coalescing on a TV 
screen. I think, from that moment, I wanted to learn more about how it was done. I was hooked 
on media.

Fast-forward fifty or so years to last Friday.

The switch from analog to digital won't have the same poignancy as the switch from black-and-
white to color. Nor will families gather in living rooms across the country to admire the transition.



The world has changed... and so have we.

But I didn't want the switchover to occur without reflecting back on where we've been.

Television has the power to spark emotions - and memories - with the stories it tells. And, 
sometimes, the stories we tell about it.

UPDATE - June 16, 2009

Ian Hart writes:

Regarding your reflection "The end of television as we know it", where you wax 
lyrical about getting your start in broadcast television... You must be a young man. 
I got my start working on 35mm and 16mm film at the London Film School in the 
mid 1960s. I wonder whether the the constant "high" I experienced at that time 
was due to my discovery of this exciting new art form or just the effects of sniffing 
the film glue! I clearly remember the day that our Editing lecturer, David Gladwell, 
brought in the big new thing: our first guillotine tape splicer! Prior to that we had all 
had to master the black art of cement splicing (where you lost a frame in 16mm) 
and calculating "build-up" if you changed your mind about the cut. 

Like everyone else in the 1970s I had to learn video editing with its 10 second roll-
ups and loss of quality every time you made an edit and (pre-computer) having to 
re-edit everything from a hand-written EDL if you wanted to change a shot near 
the beginning... For me, video editing was a 20 year stretch in purgatory, an 
aberration. It turned the art of editing into a mechanical process. So you can 
imagine my joy in the mid-1990s on discovering digital editing, first with Premier 
1.0 and then Final Cut Pro 1.0. All the metaphors related to film editing. It was like 
coming home again. 

I'm thankful to you for all the tips and tricks and shortcuts in your workshops. They 
make my "super tape splicer" work faster, but I'm very pleased to find that the 
Wardour St. training I got 45 years ago in logging rushes, making work prints, filing 
trims, marking up opticals; not to mention laying sound tracks, marking music 
cues, recording Foley tracks, audio sweetening and mixing, etc. are all 
transferable to digital editing. 

Life is good again.

Tom Wolsky adds:

I so resemble this. I think I may have been to the same film school a couple of 
years before or after him. When I was there it was the London School of Film 
Technique. 

Larry replies: Thanks, Ian and Tom, for sending these. 
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PASSING THOUGHTS

I get a lot of comments from folks passing along interesting things they've found. Up until now, I 
haven't had a good place to put them. Now I do - Passing Thoughts.



CORRECTION

In the "correcting my errors" category, when the RED camera first came out, it shot video-only; 
audio needed to be recorded to a second system. I thought this was still the case and it wasn't 
until last week that Eric Harnden corrected my misunderstanding.

RED cameras record both video and up to four channels of audio. Here's a forum posting that 
explains this: http://reduser.net/forum/showthread.php?t=31583
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MORE ABOUT RED 

David Wakeling sent me the following:

If you're not familiar with transcoding Red footage, here's a workflow for using 
Color (but does not take into account any effects on the clips): 
 
http://www.reduser.net/forum/showthread.php?p=416890

Larry replies: Thanks to both David and Eric. 
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FREE PLUG-INS

Jeff Brenes writes:

Recently I found this site with some nice free plug-ins for FCP, and I thought that 
may be you would like to taste them and/or publish in your monthly newsletter for 
others to use them....

http://alex4d.wordpress.com/finalcut/

Larry replies: I had the pleasure of meeting with Alex Gollner on my recent seminar trip to 
London. He is great fun to talk with and has a very interesting website.
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FILM AND VIDEO BUDGETING 

At the recent one-year birthday of the LA Post Production User Group, I had the pleasure of 
meeting Deke Simon, author of the Film and Video Budgets book.

http://reduser.net/forum/showthread.php?t=31583
http://www.reduser.net/forum/showthread.php?p=416890
http://alex4d.wordpress.com/finalcut/
http://www.lappg.com/


First, I was interested to learn this book existed (you can find it here: http://www.amazon.com/
Film-Video-Budgets-Revised-Updated/dp/1932907106/ref=sr_1_1?
ie=UTF8&s=books&qid=1245090054&sr=1-1)

Second, I was even more interested to learn about Deke's projects. As he says, "For the last 
dozen years I have focused on docs specifically for and about people in recovery from addiction 
and crime...an interesting niche."

Check out his latest work at: www.methinsideout.com
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LAYING BACK TO VIDEO TAPE

Ben Balser and I got into a discussion this last month on laying back to video tape. During 
which, I realized that many new editors have not had the experience of work with tape. So, just to 
put this into writing before it becomes as archaic as how to churn butter, here it is.

Most final deliveries for high-end productions are output to video tape, either HDCAM or HDCAM 
SR and not delivered as a file. When outputting to tape, you need to allow room for leader 
material which the engineering types use to make sure the tape playback matches the spec of 
when the tape was recorded. 

Traditionally, this leader material is:

Timecode Content
00:58:30:00 Bars and tone 

00:59:30:00 Black audio and video 

00:59:40:00 Program slate 

00:59:50:00 Black audio and video 

01:00:00:00 Program start 

A program slate consists of:

�●     Program Title Producer / Director / Agency responsible
�●     Date output to tape
�●     Running time (Never include frames and always round up)
�●     Audio mix format (stereo, mono, multi-track)
�●     Timecode format (Drop-frame or non-drop-frame)

To create these leader materials in Final Cut you can either use File > Print to Video, or build 
them yourself in the Timeline. If you create them in the Timeline, go to Sequence > Settings > 
Timeline tab and change the sequence timecode to 58:30.

That way, the timecode of your sequence will match the timecode on your tape. Note, to make 
sure all your program times are correct, use File > Edit to Tape to record to video tape.
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http://www.methinsideout.com/


MORE ISSUES WITH STORAGE

Robin Harris sent me a recent blog posting about configuring a video infrastructure. He writes:

There's an interesting discussion of configuring a 100 TB 2k and 4k video system. 
The original question came from a small Hollywood production house.

Lots of discussion by smart storage people and thought your readers might be 
interested.

You can read it here: http://storagemojo.com/2009/06/07/configure-a-100-tb-hd-
video-infrastructure/

Larry adds: While I disagree with the numbers in his chart of video data rates, the fact the that 
video files are HUGE I agree with. I think his post is interesting. 

[ Go to Top. ] 

8 MM CAPTURE

A while ago, Martin Weiss wrote asking:

You've had a couple of posts on 8mm film transfer of late. Talking of which, there 
is one thing I have been looking for. We do a number of transfers from film to 
video, using a custom-built projector which allows us to film straight from the film 
gate. This, naturally, means that all pictures are upside down.

Do you know of any tool that lets you flip the video during capture?

Recently, Martin sent me the following update:

I finally found a tool that lets me do this and take care of the interlacing. It is even 
free-ware. The name is "JES deinterlacer" over at http://www.xs4all.nl/~jeschot/
home.html
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CREATING VIDEO CREDITS

Adrian writes:

I was just reading your article on making scrolling movie credits with livetype, and I 
was wondering if you have ever tried Video Tagger?

http://www.ElectricHappiness.com/VideoTagger_Home.jsp

Larry adds: I've never used this, but I'm happy to spread the word.

http://storagemojo.com/2009/06/07/configure-a-100-tb-hd-video-infrastructure/
http://storagemojo.com/2009/06/07/configure-a-100-tb-hd-video-infrastructure/
http://www.xs4all.nl/~jeschot/home.html
http://www.xs4all.nl/~jeschot/home.html
http://www.electrichappiness.com/VideoTagger_Home.jsp
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DENOISE FILTERS

Jeff Brenes sent me this:

I was reading your last newsletter and saw that someone was asking for some de-
noise filters. I don´t know if you already have hear or write about this filters, but if 
not let me tell you, I found them on this website

http://www.mattias.nu/plugins/

And I think they are very helping and useful, by the way they are free.
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QUICK ZOOM TIP

John Thomas sent this in:

I was working on a project and doing my usual zooming in and out and always 
having to adjust to get in on my markers etc. when I thought I would try a 
photoshop trick of drawing an area with the zoom tool and see if it worked 
the same as PS. Wow, it did! This will save me a ton of time. So I thought I 
would pass it along as I never saw this tip anywhere else.
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CONVERTING FLIP CAM FOOTAGE

Dustin Young sent this in:

First off I wanted to say that I really enjoy your newsletter, and your workshops as 
well. This is a response to a question you recently answered in your May 
Newsletter in regards to working with Flip Cam Footage. 

I recently finished up a reality series that I was the online editor on, and was given 
the task of converting about 30 hours of this FLIP footage to files that would work 
in FCP - As they don't work in FCP in their native MPEG-4 Format. While MPEG 
Streamclip is great, you can actually convert using Compressor by itself. Simply 
import them in to a compressor project, set your destination, then apply the of your 
choice.

These are the video compression settings I used:

�●     Apple ProRes 422, 23.98, 1280x 720
�●     Audio Settings

http://www.mattias.nu/plugins/
http://www.larryjordan.biz/seminars


�●     Stereo, 48khz, 16 bit, and select the audio compressor of your choice.

After I did I batch process, the files they imported into FCP flawlessly. Special 
Note: Converting the audio is equally critical, since the Flip HD cameras record 
Mono, 44.1 khz, and when brought into FCP our editing team ran into issues with 
sync on long clips in the time line. Hope this is helpful to everyone, and with the 
relative inexpensiveness, and ease of use of those cameras more and more 
productions are using them for self recorded OTF interviews. 
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WORKING WITH MXF MEDIA

If you are working with MXF media in Final Cut Pro - such as P2 and XDCAM EX - check out this 
site: http://mxf4mac.com

Björn Adamski is a regular reader and his company makes products that can simplify your MXF 
life.
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COPYING AND PASTING TEXT INTO FCP TEXT CLIPS

Andy Lindsay sent me this:

OK, I think I’ve figured something out. Using TextEdit, I went into the preferences 
where, by default, the text format was Rich Text, and I changed it to Plain Text. 
After that I was able to copy and paste into FCP and the formatting was intact. 

Just for the heck of it I then tried copying and pasting from Adobe InDesign into 
FCP but it did not work. Copy from InDesign then paste into TextEdit then copy 
and paste into FCP and it does work. 

Larry replies: Andy discovered the secret. FCP expects all text to be plain, with no hidden 
formatting codes. That's why Text Edit is necessary. It creates plain vanilla text.
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READER MAIL

WHAT WILL THIRD-PARTIES DO?

Eric Mittan sent in a question I got from a number of people:

A question I have after the Apple announcements is whether or not AJA, 
BlackMagic, Matrox, etc., will be able to make capture boxes or devices that 
interface with the SD card slot on the new 15" and 13" MacBook Pros. With your 

http://mxf4mac.com/


industry contacts, can you put out the word to those in the know and ask whether 
that's even technically possible? 

No need to reply to me directly, simply put the answer in a Pick Our Brains 
segment of the Digital Production BuZZ, or ask it directly to a guest you have on 
the buzz.

Larry replies: Eric, the SD slot is NOT the friend of the video editor. At BEST, it runs at 30% of 
the speed of an Express34 slot (30 MB/sec vs. 95 MB/sec). The short answer is that there is no 
reason to create capture cards that support the SD slot when, as currently configured, the SD 
slot can barely handle a single stream of ProRes HQ HD video.

In fact, the whole MacBook Pro "upgrade" has me deeply concerned. Here's a blog posting I 
wrote that goes into more detail:

http://www.larryjordan.biz/app_bin/wordpress/archives/692

Plus, I'm now reading that the internal speed of the SATA drives has been cut in half! While not 
as debilitating as the SD port, this is also not a trend that make me feel warm and fuzzy.

Barefeats.com ran an article on this same subject:

http://www.barefeats.com/wwdc09a.html

I'm REALLY disappointed in this latest round of Pro laptop updates and am hoping that we can 
all let Apple know they are moving in the wrong direction!
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PIXEL PUZZLEMENT

Michael Freedman asks:

Just a quick question if you have time... I was wondering why when I set my final 
cut timeline to 720/576 it says in sequence settings that it is 5:4 when it's really 
4:3?

http://www.digitalproductionbuzz.com/
http://www.larryjordan.biz/app_bin/wordpress/archives/692
http://www.barefeats.com/wwdc09a.html


Larry replies: This is often a hard concept for people to understand.

The answer is that 720 x 576 is 4:3 - because the image pixels are not squares, they are 
rectangles. In the case of PAL 4:3, each pixel is tall and thin.

As this image illustrates, both black boxes are 4:3. However, the left box is filled with 12 square 
pixels, while the right box is filled with 15 rectangular pixels. Converting the aspect ratio of the 
pixels between square and rectangular does not change the 4:3 aspect ratio, but DOES change 
the number of pixels needed to describe the shape.
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SOME ELEMENTARY QUESTIONS

George Godfrey writes:

I'm new to Mac and FCP worked with windows mostly anyway I've just registered 
at your site and have two questions if you don't mind. Excuse me if you find them 
elementary.

1. When I make a QT movie from my timeline in 16.9 and then reimporting the file, 
I end up getting it 4.3 format and is it suppose to be so? I've looked everywhere to 
find the box to tick in for the correct format but alas.

2. When capturing a full dv tape I see in the capture map later that several files 
appear, the captured film file or files, plus QT symbol files that can't be opened, 
but if trashed the film file won't open either. What is this file and why is it splitting 
into separate files when using capture now?

Larry replies: Thanks for writing, George! These are two great questions.

1. After importing the QT clip into the Browser, but BEFORE editing it to the 
timeline, scroll right in the Browser until you find the Anamorphic column. Check it 
ON for all 16:9 QT clips.

2. You have an incorrect capture setting. Go to Final Cut Pro > System Settings 
> Scratch disk tab and UNcheck the second checkbox from the bottom - Limit 
File Size to ... 

Also, it is bad form to capture an entire tape unless you have a continuous performance. FCP 
works better when you capture shorter clips.

UPDATE - June 16, 2009

Tom Wolsky also points out:

This [also] happens when the capture drive is incorrectly formatted usually FAT32, 
which has a file size limit.

Larry replies: Thanks, Tom, I forgot that. 

UPDATE - June 16, 2009



Ian Hart writes:

Regarding your reply to George Godfrey about capturing the entire tape vs 
individual scenes. Since moving into HD (MiniDV) I've found it much more difficult 
to accurately find shots, spool through the tape, set In/Out points and log the 
shots, due to the fact that HDV is encoded as a MPEG-2 sequence of I , P & B-
frames rather than individual frames as in DV. These days I find it more 
convenient to capture the entire tape with the "Create new clip on start/stop" 
checked and "Limit capture to 62 mins". I then use a tool such as Adobe Bridge to 
review and notate the captured clips, rename them, throw away NG takes, etc. I 
then trash the clips in the browser and re-import the logged clips from the project's 
Capture folder. Perhaps it's because I'm an old film editor and this sits more 
comfortably with my workflow (see below).

Larry replies: I agree, keeping clips short is a good idea. And I, too, am a fan of Adobe Bridge -- 
so much so that I created a video tutorial explaining how to use it. 
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TIPS TO FASTER RENDERING

Ed Dadulak, a cinematographer I enjoyed working with in Boston television when both of us 
were MUCH younger, recently asked:

I have become a user of FCP just this past January. Your tutorials are great, clear 
and fun as are all the tutorials on Lynda.com.

I have a Sony F900 HDCAM which I don't capture into FCP since I do not have a 
deck. Let my clients do that. Moreover, I have the Canon 5D Mark II that records 
1080P 30 frame video as you are probably aware.

I have tried transcoding using the Apple ProRes 422 codec in FCP, however it 
takes an incredibly long time for just a few minutes of video. Would I be better off 
using Compressor? I would rather be editing than watching that blue line moving 
at a snail's pace.

Larry replies: It is always good to hear from you. Your file sizes are way past HUGE with the 
Canon camera, so transcoding will take a while.

Yes, Compressor will speed things up because it runs in the background -- allowing you to do 
other things, like edit.

Things you can do to speed the transcoding process are not cheap, but include using a computer 
with:

1. An Intel chip - ProRes was not designed for a G-5 
2. A computer with a faster clock speed 
3. More processors in your computer 

At a minimum, though, try using Compressor to convert your images to ProRes HQ. 

[ Go to Top. ] 
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FROM MOTION TO COLOR TO FCP

David Wakeling writes:

I have a workflow question regarding going from FCP to Motion to Color. I've 
searched the many forums online, but have yet to find a clear answer, hope you 
can help.

I'm editing a short film shot on the Red camera and have converted everything to 
ProRes 2K, and now most of the scenes have been built in FCP. In every scene 
there are effects and transitions that I would like to create in Motion. After all these 
effects are done, we planned on sending the project to Color for grading. As Color 
does not accept Motion files, and the colorist will shoot me if I send him a self-
contained quicktime file of the entire film, what is the workflow here? 

As an added curve ball to contend with, I'm editing an "offline" version now and it's 
recommended to convert the raw files back into the Red codec before color 
correcting.

Larry replies: Color only wants to work with actual video files - not LiveType or Motion project 
files. Whether you use After Effects or Motion, the workflow is the same.

Create your effects in Motion. Export each effect as a single SELF-CONTAINED QuickTime 
movie. If you need to retain transparency information, export using the Animation codec. Import 
these movies into FCP and edit into the Timeline. This would be the same workflow when 
creating effects in After Effects. You need to create a self-contained QT movie.

Ideally, only create the Motion effects when you are in the final on-line stage - that way you are 
working with native RED files. On the other hand, the time needed may cost too much.

Then, bring the entire project to your colorist as a Final Cut project - using final resolution media - 
with the self-contained QuickTime movies of your Motion effects. They will then color correct 
everything at once.
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POWERPOINT (AND KEYNOTE) IN FCP

Barry Drennan asks:

Could you please tell me whether it is possible to add a PowerPoint presentation 
into a FCP sequence?

Larry replies: Yup!

Whether you use PowerPoint or Keynote, you can bring that info into FCP by exporting it as a 
QuickTime movie, then import that QuickTime movie into Final Cut.

However, people design for PowerPoint differently than for video, and you'll have problems if you 
don't take a few extra points into consideration:



�●     Create, or resize, your PowerPoint to be as close to the final video resolution as possible. 
Generally, a size of 1024 x 768 , for SD, or 1280 x 720, for HD, works best.

�●     Reduce the amount of text on the page.
�●     Increase the point size of the text.
�●     Pay attention to all the design constraints we've always worked with in video. Even when 

presenting on HD, we don't have as much resolution as our computer screen.
�●     Transitions should export, however, slides will only output as a single frame, which you'll 

need to lengthen in FCP.
�●     Embedded movies will probably not export correctly. Generally, audio and video lose 

sync during export. Plan to replace these with the original movies.
�●     Any music in the PowerPoint file will not export, you'll need to add it again manually. 

UPDATE - June 18, 2009

Cal Deal writes:

I'm away on vacation, but I saw your newsletter. I think you're in error about 
exporting one Keynote slide frame. As long as the timings are programmed in, I 
believe they will export and play normally.

Sharon Sobel adds:

Just to follow up from your most recent newsletter. Larry, I import powerpoints all 
the time into FCP. The only thing that gets sacrificed with my method is animated 
transitions.

Here’s how I do it:

1.  Open powerpoint, and open the file.
2.  Click “View slideshow”
3.  Wait for a few seconds until the slide transition icon in the bottom corner 

disappears.
4.  Click Shift + Command + 3 on the slide---you’re doing a screen capture. 

Do this with each slide in the file. If there is a “build” on the page, do a 
screen capture between the “builds” on the page, and add dissolve 
transitions through Final Cut.

5.  You’ll end up with a bunch of .jpgs on your desktop. 
6.  Make a new folder to put them all in, and then move the folder to your 

project’s folder to stay organized.
7.  Import the folder into Final Cut. All of the slides will be in this folder. You 

shouldn’t have to do any re-sizing of the images in a 4:3 project.

Still need to bring movies in separately, as you indicated, but this process works 
for 95% of the powerpoint presentations I get, and is a pretty fast method.

Larry replies: Thanks, Cal and Sharon, for writing. I appreciate the update. 
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BETTER IMAGES THROUGH BETTER CODECS

John Foster writes:

Here's a question: My wife and I have been shooting and producing natural 
science documentaries for public TV in Canada and Japan, and for the Discovery 



Channel in Canada, for more years than we care to admit to. Because we are also 
still photographers and present public slide shows we are keenly interested in 
using FCP to fine tune music, dissolves, and the precise positions and length of 
each image -- and we want to be sure that FCP will also give us the quality we 
want on an 8 foot screen in front of a couple of hundred people.

Right now we are using Keynote, which gives us decent quality and the ability to 
include music and video -- but the adjustment of each image to the music is a little 
clunky.

Our images in Keynote are 1024x683. This displays full-frame 35mm slides.

So two basic questions: will FCP produce the quality we need when projected 
through a video projector -- possibly as a QuickTime file? And what do we need to 
do to import a full frame 35mm image into FCP? Is it just a question of sizing? OK 
that was three questions.... A good slide show may have stills, Betacam, XDCAM 
HD, HDV and DDV, all with music and SFX. For us, the easiest place to do that is 
in FCP -- but only if it projects at good quality.

Larry replies: Well, the answer is yes and no.

This isn't a Final Cut problem, it all depends upon which video codec you decide to use.

The absolute highest quality is the Animation codec, however this requires very large image 
sizes and a fast computer to play back.

Second, would be to use the ProRes 422 codec at 720p image size. This would be much smaller 
files, excellent quality, but you would need to scale your images to 1280 x 720 x 72 dpi.

So, will FCP create great quality? Yes - provided you use the right codec.

Can you play a QuickTime file directly to a projector: Yes

You import a 35 mm slide the same as any other digital image: File > Import > File(s). If, 
however, the slide has not yet been digitized, you'll need to do that first.
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MORE ON SMOOTHCAM

Tony Fleming writes:

Since I wrote to you on this subject, I have completed two additional 30 minute 
projects, each of which had significant number of clips to which I applied smooth 
cam. I did the export and re-import trick as I went so it wasn't too burdensome. 

I had no trouble at all with either project and I continue to say that SC is just magic 
and saves clips which would otherwise be unusable. I even applied it to shots of 
small whales swimming in choppy waters shot from a moving boat where there 
was no stable reference in the frame and it even worked on those.

Larry replies: SmoothCam is an image stabilization feature in Final Cut Pro 6. While I don't have 
a specific article on how to use SmoothCam, I do have some tips to make it work better:



http://www.larryjordan.biz/articles/lj_making_motion_move_faster.html
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OK, WHERE ARE MY FILES?

Nicolas Nilsen sent this in:

I went to a friend of mine to record his voice for a FCP project. I went there with 
my laptop (MacBook Pro with Final Cut Studio). I made the recording (SoundTrack 
Pro), saved the .stmp file and went back home to work on the FCP project...

OK.

Then I copied this .stmp file on my other computer and I got this warning 
message ! 
"Missing files" ! STP can't find the files ? which files ? what missing files ? There's 
just one .stmp file ... !

If I click "ignore", it doesn't work - the wave forms are missing !

WHAT FILES AM I SUPPOSED TO FIND to make it work ? where are they ?

If you could explain that, perhaps I wouldn't lose a few hours of hard work :-))) 
thanks for your kind help Larry

Larry replies: The problem is that you didn't copy all the files you needed. You need to think of 
the STMP project as similar to a Final Cut project. The project file contains pointers that POINT 
to the media on your hard disk, but the media is NOT included in the project file.

What you need to do is go back to your friend's system, reconnect the same hard drives, then do 
a Save As on your file and COLLECT all the different audio files that you recorded.

What I do for all my Soundtrack work is create a folder ("Larry Jordan project) then, inside save 
the STP Project file ("Larry Jordan intv") and Collect all audio files. This puts a media folder in 
the project folder. Once I have both the project file and the media folder, I can take it anywhere.

(Also, Nicolas, I apologize for getting your name wrong on my email back to you. I wasn't paying 
proper attention. Sorry.)
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CREATING WMV FILES

Kevin Worthington asks:

I have a 7 minute video clip that needs to be converted from a Quicktime movie to 
Windows Media. I first exported using Quicktime conversion but the process 
stalled at about 35% completed. I then exported from Final Cut as a regular 

http://www.larryjordan.biz/articles/lj_making_motion_move_faster.html


Quicktime movie but, using Quicktime Pro, the conversion to wmv still hangs up at 
about 35% completed each time. Any ideas what I may be doing wrong or if there 
is a better way to do this?

Larry replies: Kevin, I'm amazed you could even get QuickTime to start. Worse, this is creating a 
very old version of WMV. 

It would be MUCH easier to create a high-quality QuickTime movie, then use either Adobe 
Premiere (on Mac or PC) to create the WMV, or just move it to a PC and create it there.

There are a number of Mac applications that also create WMV files - Flip4Mac is the first one 
that comes to mind. I'm happy to list others if readers want to suggest them.

UPDATE - June 16, 2009

Stuart Page writes:

I like Autodesk Cleaner for creating WMV files. 

Larry replies: Thanks, Stuart! 

UPDATE - June 18, 2009

Bob Hirschfeld writes:

I've been using Cleaner for years and it works very well, although it is far more 
expensive (around $600) than Flip4Mac. The advantage is that it does an 
excellent job compressing video files, whether or not you are asking it to also 
change the clip's file type. The product has had several changes of ownership, 
and is now sold by Autodesk in PC and Mac flavors. There is a 30-day free trial. 

I shoot a lot of HDV video, edit it for non-streaming use on our website, so the files 
need to be relatively small so they can be downloaded reasonably fast. Our 
intranet is standardized for Quicktime, but for external use, I need to also create 
WMV versions. Cleaner is perfect, although I've also tried Sorenson Squeeze, 
which also works well and is priced about the same.

http://usa.autodesk.com/adsk/servlet/index?id=5562025&siteID=123112

http://www.sorensonmedia.com/video-encoding/

Larry replies: Thanks, Bob, for writing.
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NOT ALL HARD DISKS RUN AT THE SAME SPEED

Brian Seegmiller writes:

I have a Sony HDRsr12 camera. It uses AVCHD. When I log and transfer the 
footage it works OK. I have FCS 6.0.5. I am capturing using prores. When I bring it 
in the timeline it asks do you want to use the format of the clip and I say Yes.

http://www.telestream.net/flip4mac-wmv/overview.htm
http://usa.autodesk.com/adsk/servlet/index?id=5562025&siteID=123112
http://usa.autodesk.com/adsk/servlet/index?id=5562025&siteID=123112
http://www.sorensonmedia.com/video-encoding/


But when I play it back It looks like it skips frames. I'm using a Western Digital 
FireWire 800 drive. What can I do?

Larry replies: Brian, ProRes requires a hard disk with a MINIMUM of 28 MB / sec data transfer. 
This is more than a FireWire 400 drive can support. My guess is that you are using either your 
boot disk, or an external FireWire 400 drive -- neither of which is fast enough.

Here's how to find out.

�●     Run Utilities > Activity Monitor. 
 

 
 

�●     Click the Disk Activity tab at the bottom.
�●     Copy a very large (larger than 1 GB) file to and from that hard disk and watch the Data 

Read and Data Write speeds. Both need to be well in excess of 35 MB/sec.

If so, then, doing a Safe Boot / Repair permissions is probably in order. If not, the hard disk is too 
slow. Here's an article that describes how: http://www.larryjordan.biz/articles/lj_trouble.html

Brian sent the following update: 

You were right. That 800 drive is too slow. But my internal SATA drive is not. 
Thanks! 

Larry, again: This is a good opportunity to mention my tutorial on Picking the Right Hard Disk and 
Video Format. This 60 minute tutorial goes into all the detail you need to avoid problems like 
Brian just discovered. Click here to learn more. 
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EXPORTING BROWSER COLUMNS

Richard Day writes: 

Following your tip in May's newsletter, I tried exporting clip data from the Browser 
by selecting the clips and choosing Export>Batch List but ALL my clips were 
exported, not just the selected ones. Or I should say, the entire bin of clips. I 
wonder if your tip only applies to individual selected clips if they are at the "root" 
level of the Browser item/bin hierarchy?

And if so, how do I move a clip "up" so that it moves out of its bin to that root 
level? I've never figured this one out. It seems, once in a bin, never out of it 
(except to another bin).

http://www.larryjordan.biz/articles/lj_trouble.html
http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=110
http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=110


Supplementary question: I was labeling parts of clips with markers, and I was 
hoping to export the marker names (and their column info) as well as the clip 
column info. Can this be done? Export > Batch List only exported clips, not 
markers.

Thanks for your great work. After a time one gets more into working with FCP than 
learning things one didn't know, and you are an antidote for that...

Larry replies: Yeah, I got it wrong.

File > Export > Batch List exports everything in the Browser. To only export a selected group, 
probably the easiest way to work around this is to create a new project then just drag the clips 
you want to export into the new project. Not ideal, but it works.

As for how to move a clip out of a Bin, grab the clip, or clips, you want to move and drag then on 
top of the NAME column header. When you let go, they will move to the top level of the Browser.

As for exporting marker info, FCP doesn't handle that natively, but here's an Automator script 
that can accomplish this:

http://www.creative-workflow-hacks.com/2007/08/11/automator-action-final-cut-pro-xml-to-tape-
log-via-markers/
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FASTER COMPRESSION

A couple issues ago, Jason Brooks wrote:

I am writing in response to Don Smith's tip on using 'virtual' clusters on one 
machine to speed up the FCP exporting process. As almost all of the footage I edit 
is HDV, it is obviously very exciting to hear that my export times could be (even 
slightly) reduced!

Unfortunately, when I tried (and checked, reset, and re-tried) this setup, my cluster 
showed as 'Selected Service On' in system preferences, but did not show up in 
the submit dialog in compressor when I ran it.

So, I sent Jason's comment over to Don Smith, who graciously spent some time figuring out the 
problem. Here's Don's update:

I meant to update you that Jason Brooks solved his problem following my 

http://www.creative-workflow-hacks.com/2007/08/11/automator-action-final-cut-pro-xml-to-tape-log-via-markers/
http://www.creative-workflow-hacks.com/2007/08/11/automator-action-final-cut-pro-xml-to-tape-log-via-markers/


"Reducing Rendering Time" tip. He simply did it again and this time he followed 
the instructions... for the most part. All of this was for nothing, however, because 
Jason ignored the part of needing 4GB of RAM and two instances for it to work on 
a MacBook Pro. He had only 2GB of RAM and each instance takes up 1GB. After 
his two instances, he had nothing left over for the OS so it had to page to the hard 
drive and the result was that his rendering was slightly longer than if he didn't use 
virtual processors.

Larry replies: Thanks to both Jason and Don for their questions and followup.
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SSD HARD DRIVES

Adam Connell asks:

Great newsletter this month. In the next one, any chance you could give an 
opinion on the positives and negatives of SSD hard drives for editors?

Larry replies: In general, I try to avoid computer system and hard drive testing - I don't have a 
good testing system.

However, based on what I'm reading, at this point, SSD hard drives are designed for 
environments with a LOT of shaking and physical movement. At this point in time, SSD drives 
are slower and smaller than standard hard drives. And they are almost double the cost.

If you are bouncing across the wilds of America, recording to your computer which is strapped to 
the back of a bouncing jeep, then an SSD hard drive makes perfect sense.

However, if you are not in a high-abuse situation, stay with standard hard drives.
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ORGANIZING FILES

Michael Loftus asks:

You recommend that on the boot disk, create a folder called, "FCP Projects." This 
folder will hold all your non-timecode-based project files.

Is there a technical advantage to placing these files on the boot disk? e.g. will the 
file run smoother with less dropped frames, etc. I’m currently editing on a laptop 
with 4TB of external storage space where I keep the media files. I’m usually 
editing 2-4 projects at a time so I put all files, timecode and non-timecode, on the 
external drives to keep from loading up my 180G boot disk. 

Larry replies: Nope -- your system is fine.

I taught this organizational system back when everything originated on video tape. Now, as we 
go tapeless, and with the speed and size of today's hard disks, I'm thinking about my opinion. I'm 



holding off doing anything formal until we see the next version of FCP, but in the future, I'll still 
recommend creating two folders - one for media, the other for project - but suggest they both be 
kept on the second drive.
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ANOTHER FCP ORGANIZATIONAL SYSTEM

Tom Mountford, senior editor of the JMS Group, sent this in:

Hi Larry - I was reading Anna B's question on 'Where to store files' and thought I 
would share my filing system. Being extremely paranoid about keeping my data 
both organized and safe I've always operated the procedure of a single directory 
for each job - even though some may consider that placing all my eggs in one 
basket it is a basket I can mirror each evening to an external drive, or copy to my 
thumb drive to take home with me - all using a single drag and drop.

To begin with I create a folder on my RAID with the client and job name. I then 
create an FCP project, save it in the folder I just created, then I switch the scratch 
discs to also reference this folder (the only snag, but one I have got used to, is 
making sure I remember to change the scratch disc preferences each time I move 
between projects). Now that I have a client/job directory containing an FCP 
project, and the automatically created Capture Scratch and Render Files/Audio 
Render Files directories I go on to add a few extra folders of my own. These are: 
'AE' for After Effects work relating to the edit - within this folder I have sub-
directories named 'Sources' (very handy place for housing client-supplied artwork 
and logos etc) 'Workspaces' and 'Renders'. I create a folder named 'DVD' in which 
I can place the .m2v files and DVD Studio projects for the inevitable final client 
copies of the job. Lastly I create an 'Imported Audio' folder - where I can place the 
music tracks, voiceover and final mix which have been produced elsewhere and 
sent to me as files. I am now working for the most part tapeless so don't capture 
anything directly into the capture scratch directory - but I manually place my 
XDCAM footage into this folder, with the added benefit of being able to split it up 
into scenes/shoot days using the Finder/Quicklook - and then just use 'Import 
Folder' in FCP to import the pre-arranged footage bins.

I use an identical file system for every job - so I can go back to work I was doing 
three or four years ago and not have to refresh my mind where anything is. It 
makes archiving easier too - knowing 100% that everything relating to a project is 
in the one directory eliminates the possibility of 'could not locate media' warnings 
later on. 

Hope that's of help to a few people!

Larry repliles: Thanks, Tom, for sending this in! 
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WRAP-UP

Well, that's about it for this month. 

For current news and in-depth interviews on what's happening in our industry, be sure to listen to 



the Digital Production BuZZ every week. In fact, please put the free player on your website! 

�●     Visit our store and buy a couple of our latest tutorials. 
�●     Or, check out my latest video about picking the right HD format for your project. 

Also, plesae continue sending me your comments and questions. I love hearing from you and 
enjoy the conversations that develop around these stories.

Until next month, take care, and edit well.

Larry

Subscribe to Larry's FREE

Monthly Newsletter! 

Email:    

 

[ Click here for a printer-friendly PDF version of this issue. 1.2 MB ]

Legal Notes

The newsletter is free -- but does require a subscription. Please invite your friends 
to sign up at www.larryjordan.biz/newsletter.

To unsubscribe, simply send me an email and I'll remove you from the list. This list 
is not sold, rented, or bartered. The only person who knows you are on this list is 
me.

The information in this newsletter is believed to be accurate at the time of 
publication. However, due to the variety of possible system and software 
configurations, the author assumes no liability in case things go wrong. Please use 
your best judgment in applying these ideas.

The opinions expressed in this newsletter are solely those of the author. This 
newsletter has not been reviewed or sanctioned by Apple or any other third party. 
All trademarks are the property of their respective owners and are mentioned here 
for editorial purposes only.

Text copyright 2009 by Larry Jordan & Associates, Inc. All rights reserved. This 
newsletter may not be reproduced or published in any way, in whole or in part, 
without specific written permission from the author. 

Links to my home page, blog, or website articles are welcome and don't require 
prior permission. 

 

http://www.digitalproductionbuzz.com/LiveThisWeek
http://www.larryjordan.biz/training/online_tutorials.html
http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=110
mailto:larry@larryjordan.biz?subject=Newsletter comments
http://www.larryjordan.biz/nxltrs/ljnxltr57.pdf
http://www.larryjordan.biz/nxlttrs.html
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